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General Notes on Navigation

The screen is divided into four areas: the menu to
the left with navigation buttons and the page
number, which you can type in to jump to a specific
side.

The content list [2] is at the top, divided into
chapters. The glossary [4] is at the bottom, with key
words and phrases linked throughout the help files.
You can swap the glossary for an index list, as
preferred. Simple click a keyword in either case to
link straight through to a relevant help page.

The middle frame shows the current document.
There are two methods to navigate the help files:

Interactive

or

Consecutive

Select Navigation Method

There are two methods to navigate ncCAD32 's help
files:

1. Interactive Navigation.
This allows you to control which texts you view by
hovering the mouse over the relevant hotspots in
the illustrations.

2. Consecutive Navigation.
This mode leads you sequentially through each
help page. All available details are shown one after
the other. Click the 'Next page' button (right arrow)
in the left navigation panel [1] to move one step
onwards.

1 2

3

4

Important Note
ncCAD32 is machine-independent software. It offers a multitude of functions, some of which may not be
supported by your machine. This online help document describes the general functions of the program using
illustration which - dependent on your machine, post-processor and purchased options - may vary from the
display on your system. The continuous development of ncCAD32 can also cause differences between the
screenshots shown, and what is shown on your workstation. Please first compare the revision number of your
help documentation to that of your software, and check our Website to see if there is a newer version available.
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Drawing Your Own Components.

ncCAD32 represents a tailor-made tool for the
creation of cut-/punch parts. You can create
geometric figures and have all possible options for
constructing a drawing.

Note:

If in the next pages you see 'click' this means left
click, unless specifically noted otherwise.

The cursor can be moved with the mouse, via the
command line or with the arrow keys.

Letters in angled brackets (<Esc> <Enter> <A>)
describe buttons on your keyboard.

This is the interface of ncCAD32 . The middle frame is
a drawing board, the header and footer areas are
menu, command and status bars.

The program is dongle-protected and must be
authorized for use.

1
2

3

4
5
6

1

The menu bar allows you to start new drawings or import existing ones, set formats for colors, lines and
pens, launch drawing commands, edit your drawing and set general settings. The menu items are
described in the 'The program's most important menu items' chapter.

2

This icon bar offers a selection of most commonly used drawing commands available at the click of an
icon (quick-key). You can configure this panel; there is a description of the basic settings in the
'Entering commands via the symbol bar' chapter.
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3

This is the 'Drawing Board' with a cursor in the middle, shown by a hairline cross. Right-click in the
drawing area to access a Pop-up menu , via which you can give instructions to the program for
searching elements or displaying the drawing.
You can move the drawing in any direction, holding the right mouse key.

If you pressed the symbol for displaying 'information about geo-elements' in the format bar [4], the
information will be shown in the status bar when you place the cursor over an element in your drawing.
A symbol corresponding to the geo point will be displayed at the cursor when these are touched.

Use the mouse wheel to zoom in and out around the cursor position.

31
The top area gives instructions for Searching for elements around
the cursor. The menu items in the middle allow you to control the
display and the last menu item sets a new zero-point.

Alternatively, you can zoom in and out by using the left and right
mouse buttons while holding <Ctrl>, or also use the <+> and <->
buttons.

32
The search menu items in the Pop-up menu mean, from top to
bottom:

1. Find the nearest geo point to the cursor.
2. Find the nearest element that is touched by the cursor rectangle.
3. Find the nearest intersection inside the cursor rectangle.
4. Find the mid-point of the element inside the cursor rectangle.
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33
The menu items for display settings in the Pop-Up menu mean,
from top to bottom:

1. Go to the origin.
2. Zoom in.
3. Zoom out.
4. Return to the original zoom size.
5. Move around the drawing board.
6. Re-draw the drawing, fragmented parts will be swept clear.
7. Fit the workpiece to the screen.

34
A drawing has a zero-point in the bottom left corner. This
is declared as 'zero-point 0'. You can move the
zero-point at any time, the new zero-point is then
identified as 'zero-point 1' (here to the left below the
cursor). For a description of this procedure, see the
'zero-point' chapter.

4

The 'Format line' shows the defined formats for line type and style, and offers options for switching the
display of elements on and off. The penultimate icon enables the display of information about the
drawing element the cursor is resting on.
Use the furthest icon right to show or hide the grid; important when starting a new drawing. Tip: The
grid can obstruct when trying to 'capture' geometry points. In this case, simply hide it.

You can abort any command sequence by pressing <Esc> or right-clicking.

5

This is the program's 'Command line'. This line allows you to enter commands and their codes more
accurately than with the mouse. The commands can be found in the descriptions of the draw functions
as a stand-alone document (DE only).
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The command '499 114' allows you to merge various commands to a batch, with its own symbol
(shortcut). Than you can call this shortcut (with a point as prefix) in the command line.
The next step in the editing sequence will be shown when using text mode. If you wish to abort an
editing sequence, press the <Esc> key.
The command line can also appear in an input format, whereby the content of the line changes
according to the instructions you gave the program.
The input format can be activated directly by pressing <F2>. You will find a description of the content in
the functions' corresponding pages.

51

You can enter the position of the cursor in input format, either as X/Y coordinates, or polar coordinates
(angle, offset). Press the corresponding button in the left panel and enter the required position. Click
the arrow button next to the position field to move a marker to the new position. Click the 'Apply' button
to move the cursor to the marked position.
The bottom buttons on the left panel allow you to move the cursor to a new position using a triangular
calculation.
To keep the input format active during further editing, mark the checkbox at the far top right. The
second selection box allows you to set whether the inputs are absolute or relative to the origin.

52

To enter a new cursor position using a triangular calculation, choose first between the side lengths and
the angle of the side, and enter a value under X or Y. The cursor will jump directly to the newly
calculated position.
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53
You open this dialog with the command '499
114'. Here, you can build sequences of
commands and give them an own symbol
(shortcut), that can be called either in the
geometrie or in the technologie with this
symbol.
All available shortcuts are listed on the left.
Selecting an entry from the list, the
sequence of commands is shown on the
right. Click on 'Start', to enter a new symbol
and the belonging commands.

54

Enter a new symbol (shortcut) for a sequence of commands here. You can than call this symbol with a
dot as prefix (.K1 in this example).
This function allows you to build sequences using commands either from the geometrie or (with the
command 340) from the technology.

6

Status bar with information about the cursor position and the drawing. In the text fields to the right are
the current layer number, pen number, line type and zero-point. The current zero-point is important for
positioning a start-point when drawing new elements.
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Mouse And Cursor.

To adapt the display of the cursor to the points of a
contour element, first select that function. Click the
toggle button 'Format panel'. When the function is
activated the cursor will jump to the next geometric
point.

The left and right mouse buttons together with the
control-keys <Shift> <Alt> and <Ctrl> can be used
as quick-keys to help work progress more quickly.

ncCAD32 has some special functions to ease creating
and editing drawings.
The mouse buttons can be used in conjunction with
the control-keys <Shift> <Alt> and <Ctrl> to access
various functions.
The display of the cursor can adapt to the appearance
of the next contour element's point.

1

2

1
When the function for displaying information on the
geometric points is activated, the cursor display
adapts and snaps to the next point. This makes it easy
to find specific points.

The symbols represent:

a) Arc points: center, start, end and middle.
b) Circle points: quadrant, center, tangent point,
reference point.
c) Vector points: start, end, center.
d) Intersection and perpendicular point.
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2
The mouse buttons' functions combined with the control keys are:

Shift + left-click: redraw the drawing layer.

Shift + right-click: redraw the drawing layer placing the clicked point in the center of
the view.

Ctrl + left-click: zooms in on the current layer by a factor of 2 centered on the clicked
point.

Ctrl + right-click: zooms out on the current layer by a factor of 2 centered on the
clicked point.

Alt + left-click: moves the cursor to the next geometric point.

Alt + right-click: moves the cursor to the center of the view.
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The Program's Most Important Menu Items.

The menu bar allows you to start new drawings or
import existing ones, set formats for colors, lines
and pens, launch drawing commands, edit your
drawing and set general settings. Some menu
items are available directly from the symbol bar.

The menu bar in ncCAD32 .

1 2 3 4 5 6 7 8 9 10

1
The 'File' menu allows you to create
drawings, load drawings, and import and
export drawings and layers, define and
execute programs, print and lastly 'Exit'
the CAD module.

13
When creating a new drawing you can select a
predefined size from the list or create your own
format.

The bottom frame allows you to select or enter the
scale of your sheet.
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11
Drawings and layers can be exported from the
module. More in the chapter on 'Exporting
drawings and layers'.

12
This dialog allows you to connect with external
programs which you may wish to use while using
ncCAD32 . The programs listed here are added to
a submenu under 'Execute...'.
Click 'Insert' to add a program to the list.
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2
Under 'Edit' you'll find the options for selecting and editing drawing
elements. To edit an element you must first select it, then click the
relevant edit command. The editing options are described in their own
help page.

3
'Display' allows you to redisplay your whole drawing, or zoom on a
particular region.

4
Commands in this menu will sometimes call a command which
requires further input, this will be prompted in the command line.

'Format' allows you to set rules for colors, lines and pens, and
manipulate the origin. Entry is made in a dialog.
Rules allow you to group elements for better control and structure
when editing.
'Scale' allows you to set the scale for your screen. The scale can be
set only for an empty layer or new drawing.
'Cursor step' defines the cursor's X/Y step size in mm when using
the cursor keys.
'Format' allows you to set the DIN paper size [0..4] of your drawing.
The 'Settings' menu item allows you to change parameters for
Windows ® as well as ncCAD32 .
The last item 'Search area' defines the search area size around the
cursor. This is shown visually by a larger or smaller cursor size.
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41
Set the pen types and allocate types, thicknesses
and colors to your lines. Tip: the pen thickness is
only shown when the selection box 'Show pen
thickness' is checked.

The line types are given certain functions when
editing. Line type 0 means cut lines, 2 and 3 are
markings and 5 is an open contour. The other
numbers are post-processor dependent, more
information can be found in your post-processor
help.

42
Enter window size and program color
settings in this dialog. More program
settings in the second tab.
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43
Program settings for ncCAD32 can be made
in this dialog. Select the language and mark
the relevant checkboxes. Under language
enter 'D' for German and 'E' for English. To
join all layers to one large layer, mark the
bottom checkbox.
The frame to the bottom left allows you to
enter a default drawing name, scale and
paper size.

The 'Program starter' frame allows you to
open the license manager with the 'settings'
button. Here you can add modules and
permissions to your license. The program
and optional modules are dongle protected
and can be accessed only with an
authorized dongle.
The dongle can be used locally or a network
dongle can be used from your server.
Authorization of a dongle is carried out by
IBE Software GmbH or our dealers; click the
'license window' to learn more.

44

Authorization is done by swapping 8-digit authorization codes, or using a license program from IBE
Software GmbH or an authorized dealer. The dongle will keep your codes up to date and insure secure
licensed use of the software. If you reach the end of your licensed use of the program then your dongle
will need to be reauthorized by IBE Software GmbH or an authorized dealer.
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Authorization will be made through a dialog:

1. Call your maintenance partner.
2. Select the program starter.
3. Tell your maintenance partner your customer code as displayed in the license window.
4. Your partner will give the new license code, enter this here to reauthorize your system.

When using a IBE dongle, authorization/maintenance is carried out using a license file which is
updated online simply by clicking 'check Internet'. The license files are individually created for each
dongle, and the dongle must be identified by the license server before a new license file is issued.
The license file can also be sent to you offline and copied into your system this way. To do this click
'Install license file'.
Another option would be an extension using an authorization code which can be entered in the 'Manual
entry' frame.

5
'Draw' contains the commands for adding elements to your drawing.

Circle
Arc
Ellipse
Tangents

have sub-menus for detailed user entry.

These commands are started with one click:

Line
Rectangle
Rounding
Spline

'Engraving' begins the command sequence for adding an engraving to your
part.

The macro block contains predefined macros sorted by function.

If a digitizer board is connected to your system, the bottom menu item will
open the interface and begin Digitizing. Menu items are displayed only if
the relevant optional program module is installed.
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51
Drawing circles with various start points.
Examples in the relevant chapters:

Circle using radius.
Circle at two elements.
Circle at three elements.
Circle through three points.

52
Drawing arcs with various starting
information. Examples in the
relevant chapters:

Arc through arc points and center.
Arc through three arc points.
Tangential arc from an element.
Tangential arc from two elements.
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53
Drawing ellipses with various data. Examples in the
relevant chapters:

Full ellipse with all data.
Draw full ellipse from lines.
Draw full ellipse from arcs.

54
Lay tangents on one or two circles. Examples in the relevant
chapters:

Tangents on one arc/circle.
Tangents on two circles.
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6
This menu allows you to add construction lines freehand or from
existing drawing points. More information in the chapter on
'construction lines'.

7
Modify drawing elements as you require. Select the relevant menu item and
identify the required elements as prompted in the command line.

Trim - Allows you to stretch an element to meet a bordering element.
Adapt - shortens an element to the next drawing point.
Draw equidistants (see chapter on 'equidistants').
Separate - Removes a section of an element between two other elements.
Divide - Divides an element into n equal parts. The command is executed in
the command line (selection 3) and you will be prompted for the number of
parts.
Create corner - Joins two elements to form a closed corner.
Join - Joins two elements.
Area scale - Adds a scale to the drawing; release using 'Redraw'.
Remove rounding - Removes a fillet from a corner.

8
Find and edit simple texts for ncCAD32 . See the chapter on
'entering simple texts'.
'True-type texts' have their own submenu.

81
Find and edit true-type texts. See the chapter on 'entering
true-type texts'.
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9
'General' settings and definition of measuring
methods.
This menu allows access to dialogs for setting the
grid parameters, undo parameters and function key
usage.

The options for dimensioning are offered in their own
submenu.
The use of symbols is described in its own chapter,
as is measuring.

91

'XY Dimensioning' allows lines and construction lines to be dimensioned with cascading lines, with or
without dimension numbering. More information can be found in the 'Dimensioning' chapter. For point
dimensioning, select the corresponding submenu.
There are separate dimensioning functions for angles, arcs and circles; these are called via the input
field.
Settings for dimensioning can be made under 'Parameters'.

92
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'Point dimensioning' allows you to mark a measurement between points. More information in the
chapter 'Dimensioning between two points'.

93
The menu item 'Measure' allows you to precisely
check all sizes. Notice and follow the prompts in the
command line, to reach your required result.

94
This dialog allows you to setup the grid parameters. Enter the grid
size and mark the checkbox for snap to grid. The bottom frame
allows you to set a snap to grid delay to allow you to also click
between grid points.
Enter the conditions to be used when redrawing.

The grid display can be activated and deactivated using a button in
the format line.
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95
The 'Undo settings' dialog allows you to
switch the undo function on or off, and set
the number of undo steps that should be
retained.

96
The 'Function key usage' dialog
allows you to define commands
that should be executed when you
press the f keys from <f5> to
<f12>. Enter the command code
here, or drag-drop a command
from the list to the right.
Remember to confirm and save
your selections before leaving this
menu.
Click 'Load' to access saved
favorites; you can use different
files for different selections / job
types.
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97

The 'PArameters and Settings' frame allows you to enter the margin conditions for dimensioning. Set
the dimensioning line, numbering and arrow sizes. Click 'confirm' to save your settings.

10

'NC processing' allows you to make all settings required to turn a drawing into a machineable part.
Processing modules can be stamping or cutting modules which create NC code in cooperation with
your post-processor.
These functions are optional, see the chapter 'NC processing'.
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Drawing Layers

Layers are automatically applied when importing a
drawing. A tab will be added to the drawing [1] for
each layer, allowing quick switching between
layers.

A layer can also be empty! Management is
completely left to the user, thus there are two
commands 'delete' (i.e. empty content) and
'remove'. You can also add layers at any time.

The element count for a layer is limited to 4000, If
you need to create larger drawings with more
elements than this, you can join two layers together
and edit them this both at the same time in this 'one'
very large layer. The layer setting is then
superfluous.

Drawings can be made up of multiple layers. Layers
allow you to group various functions and give your
drawing structure. Thus you can keep dimensioning
texts separate from holes, separate from etched texts,
or keep all drilled holes separate from cut holes.
ncCAD32 can work with up to 100 layers.

1

2

1

A tab is shown here for each layer used. Click a tab to switch to the corresponding layer. Right-click for
a context menu with options for layer management.

11
This menu allows you to manage your layers. You can create layers,
delete their contents, and remove empty layers.
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2
The status line shows the current layer number. Click this field to open a
context menu with options for layer management.

21

The list to the left shows the drawing layers. Click a list entry to open the corresponding info tab to the
right. The 'Drawing parameters' tab allows you to enter the format and create 'New layers'. To edit a
layer, select it in the list to the left, this opens the layer tab.
Right-click a list entry to open a drawing menu or layer menu.

22

The frame to the right allows you to change a layer's format.
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23

This tab gives information on a selected layer and a preview in the right-hand frame. To edit the
drawing, mark the corresponding line in the list to the left, the drawing tab will be displayed.

24
This menu allows you to manage your drawing layers. You can
create layers, empty their contents (delete) and remove empty
layers.

25
This menu allows you to manage your drawing layers.
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Construction Lines and Identification

Construction lines can be generated using the
menu panel or the Icon bar .
Construction lines can become part of the
workpiece (note the trim functions ) or be deleted
when the drawing is completed. In this case it is
useful to use a separate pen number or line type for
easy identification later on.
Simple construction lines are always drawn across
the displayed area; choose from:

Parallel construction line.
Vertical construction line.
Horizontal construction line.
Construction circle from two elements.
Construction line at a given angle.

You can also use special construction lines such as
a tangential construction line or Equidistant. For
drawing you can may also find the 'parts' function
useful, whereby a section is separated into equal
parts.

Construction lines are an important step in creating
you parts. Construction lines give a reference point
while building your workpiece. The usefulness in
ncCAD32 is stronger still through precise recognition of
points including centers and intersections.

Lines can be identified individually or in blocks,
ncCAD32 offers several options.

1

2

3

1
In this example the construction lines are shown as
dashed lines. The upper side of the right-hand
rectangle is selected, visible by the marking of the
end points and center. Right-click to access a menu
to identify lines in a block.
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2

Click the left-most button for selection mode. Next select a contour element or stretch a box to
selection more than one element.

Click an element to mark its drawing points. You may then drag and drop individual drawing points.
Press the space bar to select a whole contour group.
Right-click a drawing point to open a info dialog on that point.

Right-click on the drawing board to access a selection menu for identifying whole contour groups.

Press <Esc> to exit the function.

<Alt>-click to snap to the nearest drawing point.

21
In this dialog allows you to change a drawing point's
parameters. The dialog's content is
context-sensitive.

22
This menu allows direct access to various
functions. You can identify groups of contours or
transform to another form. Skilled use of
transformation allows noticeable reduction of the
overall element count.

3
Select a specific pen number or line type in connection with
the selection menu to select groups of elements according to
their next purpose.
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Entering Commands Using The Icon Bar

The icon bar functions can be moved, and in this
case grouped in the following work packets:

Empty element and exit program [1].
Open, save and print files [2].
Select, modify [3].
Undo, adapt elements [4].
Zoom and redraw [5].
Draw construction lines [6].

Draw elements.
Search and delete.
Search and measure.
NC preparation and post-processor.
DXF selection and Checker
Macros

There is a tool tip available for each icon by
hovering over it.

The icon bar allows you to access your most
frequently used commands with one click.

The icon bar is dynamic and can be adapted
to suit each user. The individual sections
can be moved in one or more rows as well
as by the left and bottom edges, and can be
shown or hidden.
There is always one empty element on the
bar to access the context menu. This cannot
be removed. Right-click on an icon to open a
menu which shows all packets. Use this
menu to alter the panel as required.

The individual menu sections can also be
separated from the icon bar and left as
floating tool windows anywhere on the
screen.

1 2 3 4 5 6

1
The empty block to the left is the icon bar's anchor and cannot be deleted. You can use this
section to access the selection menu to show or hide the individual menu blocks.

The right-hand symbol exits the program.
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11
In this menu you can see all menu sections which can be shown or hidden. Click
'Properties' to open a dialog for editing the menu points.

12
Select a menu item to view and edit its
properties.

2

In this block you'll find the icons for file management:

Create new drawing .
Load existing drawing. In this case it's a ZEW file in IBE's proprietary format. A file manager opens to
select the file.
Save drawing . If the file has been saved it will be saved with the same name, overwriting the old
version. If this is a new drawing, a file manager will open to set the save path.
Print drawing.
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3
The buttons from left to right:

Activates the 'select an element' function.
Move elements
Copy elements
Mirror elements

4

The left button undoes the last action.

The next three buttons allow you to adapt elements. The commands are identical to those in the menu
panel under 'Edit'.

Delete part element between two elements. Mark the part to be deleted. The element will be separated
and fitted to the bordering elements. Mark only one side to fit only one side.
Fit element between two elements. The overlaps with bordering elements are removed. Mark the
required side, or the middle to trim both sides.
Direct trimming of two geometric elements. Mark two converging elements sequentially to close the
gap between them.

5
These buttons mean:

Show zoom window.
Redraw. Alternatively via this pop-up as 'Reassemble'

6
These buttons allow you to add construction lines.

Draw parallel construction line.
Draw horizontal construction line.
Draw vertical construction line.
Draw construction circle on two elements.
Draw construction rectangle.
Draw construction line under an angle.

Tip: select a separate line style for construction lines to aid drawing structure
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and management.

13
These icons are for drawing elements. Note the tips in the Command line ;
you will be prompted through the selected function.

Create corner.
Draw tangential construction line.
Enter line by start and end points.
Draw circle with diameter.
Enter circle by start and end points.
Add rounding.

14
These buttons call delete functions:

Delete element.
Delete circle or arc.
Find and delete element.

15
This block offers functions for dimensioning workpieces:

Find arc.
Find line.
Display X/Y offset.
Display circle/arc offset.
X/Y dimensioning with text.
Circle dimensioning.
Radius dimensioning.
Angle dimensioning
Point dimensioning with text.
Display dimensioning parameters.
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16
In this dialog you can see and set general
information for dimensioning lines, arrows
and texts. Click 'Confirm' to save your
changes.

17

Here you'll find functions for last minute adjustments of your drawing before
processing takes place.

Delete duplicate elements.
Sort elements.
Call NC module.
Choose post-processor.

18
Quick-keys for using DXF files:

Import DXF drawing.
Save DXF drawing.
Open DXF Checker .

19

To quicken and ease recurring jobs, ncCAD32 offers a selection of macros. These can make drawing
various essential parts much quicker and easier. More information in the 'Macros' chapter.
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A Special Dialog

ncCAD32 calls this dialog for various purposes
(load, save, import, export, etc.) and the file
selection is adapted accordingly.

The system save format for drawings in ncCAD32 is
'ZEW' - a format which allows values such as
technologies to be added to a regular drawing. This
format is always used as a filter when opening
drawings. Other formats can be used via the
Import/Export options.

In the case you want to transfer the program to an
other computer, the command #467 will help you to
save and retrieve your system data.

ncCAD32 uses a special dialog to load files which
contains a file manager with various management
functions and also a preview of the files being viewed.

1 2

3

1
This screen shows the general
navigation of your directories in the top
pane, the contents of that directory are
shown in the lower left pane and a
preview of the selected file in the lower
right pane. A preview can only be
generated for the correct file types. You
can zoom the drawing (mouse-wheel),
drag (mouse-key) or display everything
(double-click).
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2
Here you can also remember preferred path names in the top
pane to help find your drawings quicker.

The lower pane is for navigating files' save paths. You can
drag and drop files from the file overview [1] to folders
displayed here.

3

This pane shows the name of a file selected to be edited, or the entered name of a file to be saved.
The recycle bin on the right allows you to delete files; drag the file to the recycle bin.
The button at the top right allows you to fix the position and size of the dialog for the next time you call it.
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Import Drawing And Layers

The menu item 'File' allows you to import DXF,
DWG and EBE files as drawings.

1. Define the drawing import parameters in the
'Settings'.

2. Import drawings in the following formats:

DXF/DWG
EBE
Mega CAD using the CDL interface

You can also create rules for allocation of
technology data to your new contours upon import.

ncCAD32 allows you to import drawings of various
types from multiple sources. For processing, many
drawing types must be adapted; i.e. the data quantities
reduced or categorized as required by ncCAD32 and
your machine. Apt settings can be used to remove
excess data and unneeded layers.

1

2

3

1

This screen allows you to load DXF and DWG files into the system.
To set rules, select 'DXF parameters' .
Click the corresponding button to select a drawing. A 'File management' dialog will open to select and
import drawings.

Imported drawings can be analyzed to check for and correct potential errors or inconstancies. Switch
to the 'Checker' for this functionality.
The bottom-left buttons help you to bring the drawing to a clear overview, complete or sorted by layer;
and identify a part of your drawing. A selected part can be saved using the bottom-right button.
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2

After loading a drawing, all its layers will be displayed here. Select a layer from the tabs below the
drawing to show its contours.
For a complete view of all layer types switch to the 'All layers' tab.
You can view an overview of all contour elements in the 'Element info' tab.

21

All available layers and line types are displayed here. Select a layer using the tabs below the drawing
and its contours will be displayed.

22
This tab gives an overview of
all contour elements in the
drawing.
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3
To allocate technology data to
a contour, select the contour
type in the Overview [2].
Define the technology
information for the contour,
mark the selection box on the
left and click 'confirm'.
You can also create a
template for allocating
technology data in order to
achieve a corresponding
clean-up of the drawing at
import. Switch to the
'Templates' tab.
In the right-hand tab you can
save multiple parts separately.

33
Presets and advanced
parameters for the individual
technologies can be entered
here.
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31
Here you can see the allocation
of technology data to the
contours. To allow ongoing use
of this allocation mark the top
selection box.
The allocations can be
manipulated here. Mark a row
and right-click to remove. A new
allocation can be made in the
next tab 'Create allocation'.
Allocations for circle can be
made direct on the drawing, to
do this click the button next to
'Program parameters; in the
second frame.
Don't forget to save the table
after making changes.
To make a complete new
allocations table select 'New' in
the 'Allocation' frame at the
bottom right.

34
Here you have an overview of
the allocation of line types to the
cutting technologies.
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32
This tab allows you to create a
new allocation of cutting
technology data for a contour.
Mark the contour type in the
Overview [2]. Select a
technology in the 'Cutting type'
frame and click 'Confirm'. The
allocation can now be seen in
the list under the 'Allocation'
tab.

The presets / parameters for
individual technologies can be
set in the 'Presets' tab.
Information about the
allocations can be viewed in
the last tab.

35
If a drawing has multiple parts,
you can save them in
individual files. Select a path
for the save location, enter a
part name and enter the
number for the first part in the
frame labeled 'Start number'.
The parts will then be saved
individually with incremental
numbering.
You can also decide which
format to save in, select the
corresponding button.
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DXF/DWG Parameters

Enter the parameters for converting external
drawing file types to the proprietary format. Check
the values carefully before clicking on 'apply' to
save.

Drawings from many sources have different file
formats which must first be converted before they can
be used in ncCAD32 . This screen allows you to use
exact parameters to trim drawings and import only set
layers.

1
2

3

1

The setting options are sorted thematically in multiple tabs:

Arcs, holes, scaling, text pens and layers.
Commands, combining and ellipses.
Poly lines and splines.
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2
Enter the values and mark the relevant checkboxes:

Convert arcs from programs including VectorCAD and
Publisher.
Close gaps up to a given size.
Scale the drawing to a given factor, e.g. from cm to inch
using a factor of 2.54.
Display circles with the given diameter (when entered).
Text-line factor height:width. If text marking lines are too
long you can compress them by entering a scaling factor of
less than 1 here.
Layer number from which the drawing should be loaded.
Load only elements of a given type.

21
Enter the values here and mark the relevant selection
boxes:

Call ncCAD32 commands after loading.
Read DXF/DWG values from the job management module.
Convert ellipses to arcs.
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22
Spline conversion:
Use limiting values to replace an existing spline with an
approximation. The dissolution of a spline can be done by
entering new vector lengths and converting to arcs.
For dissolution into vectors, enter the maximum vector
length. The default is 1.
For dissolution into arcs, enter the maximum deviation from
the original curve. The default is 0.2.
You can display the original curve to check the change
caused by your settings. Mark the selection box to convert
the spline into arcs.

In the top frame you can choose to convert polygon lines
into arcs.

Splines can be converted into lines or arcs in the bottom
frame. You can display checkpoints or the original curve to
check the deviation from the original.

3

After making these settings click confirm to save.
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Repairing Errors with the Drawing Checker.

The upper panel [2] shows all elements present in
the drawing. Those exhibiting errors are marked
with a '>' symbol.

Errors can be repaired quickly using the buttons in
the header panel [1].

The 'Elements' [3] tab in the bottom panel [4] shows
the details of an element selected in the top panel
[2], or a list of all elements exhibiting the same type
of flaw. The 'Pen/line type' tabs [3] allow you to
make settings to search by.

You can use the buttons in panel [3] to display
elements by type.

The Drawing Checker offers you a tool to check the
drawing of a component for errors and repair any you
find.

1

2

3
4

5

1

From left to right, the buttons mean:

1. Shows the selected element in the overview.
2. Undo.
3. Delete the selected element.
4. Delete all duplicate elements.
5. Check if all contours are closed.
6. Close all gaps up to the given size.
7. Join all vectors/arcs with tangential intersections.
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2
All elements that make up your drawing are listed
here. Those which exhibit errors are marked with a
'>'.
Click on an element to show details about it in the
bottom panel [4].
Flawed elements will be marked in the drawing with a
cursor.
Right-click to open a context menu with options to
repair errors.

21
This menu allows you to directly access commands for
repairing errors.

3

The 'Elements' tab shows the values for the element selected in the element list [2].
The 'Pen/line type' tab offers the option to search more accurately by a line's color or consistency.
The 'Settings' tab allows you to join tangential vectors.
The 'Join' tab allows you to join vectors and arcs according to presets such as length and angle
difference.
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4
This frame describes the vectors of an element in a
drawing, or lists all errors of one Error type if you are
searching using the buttons in panel.
The four top buttons allow you to seek for elements
with a certain type of error. From left to right, the
buttons mean:

1. Find all elements without a connection to another
element; one open edge.

2. Find all elements without any connection to another
element; two open edges.

3. Find all circles whose centers and radii are the same
as an arc's.

4. Find all vectors/arcs whose transitions are 180°.

41
This frame allows individual elements to be allocated
pen or line numbers. This 'marks' the element,
allowing elements to be removed as a group, or
searched within that group.

It is important to give open contours a special line
type when cutting them. This line type (5) can then
be cut together as an 'open contour'.

Line-type 0 signifies 'cut', while line-types 2 and 3 are
preset for 'marking'. Other types are post-processor
dependant, whereby types 2 and 3 must also be
activated from the post-processor.
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46
This frame allows you to seek the smallest of
elements (faulty elements), or close gaps up to the
given size.

42
When searching specifically by error category using
the buttons in panel [5], a list of the elements found
under each category will be displayed. Clicking on an
entry in the list switches back to the Vectors display.
Right-click to access a context menu for repairing
errors.

43
This menu allows you to directly access commands
for repairing errors.
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44
Contour groups which consist of multiple short
vectors can be joined to one vector from this tab.
Enter the limiting value for the maximum length of
vector which should be joined. If you wish to join
vectors together according to angle difference,
switch to the 'Parameter' tab.

45
This frame allows you to set an angle difference limit
for joining vectors. Enter the limiting value for the
maximum angle difference which should be joined. If
you wish to join vectors together according to vector
length, switch to the previous tab.

5

Click on 'Exit' to return to the program.
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Export Drawings/ Layers

The 'File' menu allows you to export drawings and
layers as DXF or EBE files.

Open a file manager to export as DXF files. Select
the save path at the bottom-right and enter the
filename bottom-left.

Select 'Multiple DXF export' to open a dialog to set
the naming conditions for individual exported files.

To save a layer switch to the right hand pane [1].

Drawings and layers created using ncCAD32 can be
saved as complete drawings or individual layers. You
can save as DXF or EBE files.

1

1
This pane allows you to save
individual contours to various
files. Enter the part name for
all parts, and the index
number for the first part.
Select the save path and click
the button to the left to confirm.
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11
Multiple parts from one drawing can be saved to different DXF
files. Enter the part name for all parts, and the index number for
the first part. Select the save path and click to save.
The filename is created dynamically. The buttons in the 'file
name' pane allow you to include the part name, index number
and date. Index number settings can be made in the 'Parameter'
tab.
In the bottom pane you can set whether all parts should be output
or only the selected part.

12
This tab is for making settings regarding the sequential naming
of files. The 'Filename setting' pane allows you to enter a
template which is expanded upon using your entries in the other
sections to make the complete file name.
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Various Ways to Draw Elements.

Elements can be drawn in different ways. You can
select the function via the menu, symbol bar, or
command line.

The descriptions in the following pages will follow a
tabular format.
Input via the command line is always shown as
such, with the given example dimensions as an
example. The code always stands for the
corresponding function and is listed as command
code or numerical code.

Note: If you read 'click' in the following descriptions
then, unless specifically stated otherwise, this
means 'Left Click'.
The cursor can be moved with the mouse, via the
command line, or with the arrow keys.

A drawing consists of various elements which,
when combined, give a workpiece. When drawing,
all elements are related to the origin (0 or 1).

1
23

4

1

The options for entry via the menu panel are given in the 'menu panel' chapter.

2
The most regularly used commands are easily accessible via the
corresponding icon in the Symbol bar.

3
There is also a quick access route for drawing construction lines; click the
corresponding icon in the Symbol panel.

4
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You can make direct, exact inputs about an element's dimensions in the Command Line . There are
examples listed with the required codes in the individual descriptions of each drawing command.
You can gain access to the direct value entry form by pressing <F2>.
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Set the Zero-point as Reference Point.

Define the Zero-point.
Command: NULLPD
Code: 00
Parameter: Zero-point number
Example: 00 1

Menu: yes
Symbol: no
-
Select Zero-point.
Command: NULLPW
Code: 01
Parameter: Zero-point number
Example: 01 1

Menu: yes
Symbol: no
-

Function:
Set a zero-point, or select a zero-point as a future
reference point.

1

1
Set or select a zero-point via:

1. Command Line

1. Enter the command or code and parameter into the
command line.

2. PopUp menu

1. Right-click in the drawing window.
2. Click the bottom menu point.
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Setting the Start-Point for a Draw Function.

Start-point relative to the cursor position.
Command: ST
Code: 1
Parameter: x, y
Example: 1 100 50
-
Start point relative to the current origin.
Command: STN
Code: 11
Parameter: x, y
Example: 11 100 50
-
Start point Radius, Angle
Command: STP
Code: 12
Parameter: Angle, Radius
Example: 12 30 100
-

Function:
Positions the cursor at a start-point for further
drawing commands.

1

1
Set the start-point via:

1. Command Line

1. Enter the command or code and parameters in the command
line.
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Drawing a line

Command: VEKTOR
Code: 150
Parameter: XS,YS; XE,YE- Input is made
sequentially.
Example: 150; Cursor to start point; <CR> Cursor
to end point; <CR>.
Menu: yes
Symbol: yes
-
Command: VE
Code: 2
Parameter: XE,YE
Example: 2 100 50
-
Abort the function with <Esc>!

Function: Draws a line from the given start point to
the given end point.

The VE command allows a line to be drawn from the
current cursor position to the coordinates entered as
parameters. By continually entering coordinates you
can create unbroken outlines.

1

1
Drawing a line via:

1. Menu

1. Select the function 'Draw > Line'.
2. Move the cursor to the start point, press LC.
3. Move the cursor to the end point, press LC.

2. Symbol

1. Click the 'Line' icon.
2. Move the cursor to the start point, press LC.
3. Move the cursor to the end point, press LC.

3. Command line

1. Enter the command or its code in the command line.
2. Move to the start point and press <CR> or LC.
3. Move to the end point and press <CR> or LC.



ncCAD32

Rev.1.2 Page: 54Date: 2018-5-7

You can create whole unbroken groups of lines by
continually adding lines from the last cursor position
using Code 2. Abort the function with <Esc>.
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Drawing a Rectangle.

Command: RECHT
Code: 39
Parameter: x, y, Angle
Example: 39 100 50 0

Menu: yes
Symbol: yes

Function: Draws a rectangle from the current cursor
position to the coordinates given as a parameter at
the given angle.

1

1
Zeichnen eines Rechtecks über: Draw a rectangle via:

1. Menu

1. Select the 'Draw > Rectangle' function.
2. Move the cursor to the start point, press LC.
3. Move the cursor to the end point, press LC.

2. Symbol

1. Click the 'Rectangle' symbol.
2. Move the cursor to the start point, press LC.
3. Move the cursor to the end point, press LC.

3. Command line

1. Place the cursor at the start point.
2. Enter the command or code in the command line.
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Drawing a Circle by its Radius.

Command: KR
Code: 3
Parameter: Radius
Example: 3 50

Menu: yes
Symbol: yes

-
Abort function with <Esc>!

Function: Draws a circle from the current cursor
position with the radius entered as a parameter.

1

1
Draw a circle by its radius via:

1. Menu

1. Select the function 'Draw > Circle > Center/Radius'.
2. Move the cursor to the start point, press LC.
3. Move the cursor to the end point, press LC.

2. Symbol

1. Click the 'Circle/Radius' symbol.
2. Move the cursor to the start point, press LC.
3. Move the cursor to the end point, press LC.

3. Command line

1. Place the cursor at the start point.
2. Enter the command or code and the radius in the command

line.
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Drawing a Circle Against Two Elements.

Command: HLKR
Code: 227
Parameter: GE1; GE2; Radius - Inputs are made
sequentiall
Beispiel: 227 - Enter parameters as prompted in
the command line

Menu: yes
Symbol: yes
-
Abort the function with <Esc>!

Function: Draws a circle with the given radius
tangentially touching two identified elements (GE).

1

1
Draw a circle against 2 elements via:

1. Menü

1. Select the function 'Draw > Circle > Circle on 2
elements'.

2. Move the cursor to the first element and press LC.
3. Move the cursor to the second element and press LC.
4. Enter the radius in the command line.

2. Symbol

1. Click the symbol for 'Circle on 2 elements'.
2. Move the cursor to the first element and press LC.
3. Move the cursor to the second element and press LC.
4. Enter the radius in the command line.

3. Befehlszeile

1. Enter the command or code in the command line.
2. Move the cursor to the first element and press <CR>.
3. Move the cursor to the second element and press <CR>.
4. Enter the radius in the command line.
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Drawing a Circle Against Three Elements.

Command: BO3GO
Code: 246
Parameter: GE1; GE2; GE3 - Inputs are made
sequentially
Example: 246 - Enter parameters as prompted in
the command line

Menu: yes
Symbol: no

Function: Draws a circle tangentially touching three
identified elements (GE)(inscribed circle).

1

1
Draw a circle against 3 elements via:

1. Menu

1. Select the function 'Draw > Circle > Circle on 3 elements'.
2. Move the cursor to the first element and press LC.
3. Move the cursor to the second element and press LC.
4. Move the cursor to the third element and press LC.

The circle will be calculated automatically and placed
against all three elements.

2. Command line

1. Enter the command or code in the command line.
2. Move the cursor to the first element and press <CR>.
3. Move the cursor to the second element and press <CR>.
4. Move the cursor to the third element and press <CR>.
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Draw a Circle Through Three Points (circumcircle).

Command: no
Code: 375
Parameters: SP; BP; EP - Inputs are made
sequentially
Example: 246 - Enter parameters as prompted in
the command line

menu: yes
Symbol: no

Function: Draws a circle through 3 points, perimeter
to lie on the the start point (SP), second point (Arc
point BP), end point (EP).

1

1
Draw a circle through three points via:

1. Menu

1. Select the function 'Draw > Circle > Circle through 3
points'.

2. Move the cursor to the start point and press LC.
3. Move the cursor to the second point and press LC.
4. Move the cursor to the end point and press LC.

The Circle will be calculated automatically and located on
the three points.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the start point and press <CR>.
3. Move the cursor to the second point and press <CR>.
4. Move the cursor to the end point and press <CR>.

The Circle will be calculated automatically and located on
the three points.
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11
A typical circle with the perimeter through three points.
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Draw An Arc Using Arc-Points and Mid-Point.

Command: BOGEN1
Code: 152
Parameter: XS,YS; XE,YE; XM,YM - Inputs are
made sequentially.
Example: 152 - Enter parameters as prompted in
the command line.

Menu: yes
Symbol: no
-
Abort function with <Esc>!

Function: Draws an arc with (S)tart-, (E)nd- and
(M)id-points.

1

1
Draw an arc from its start-, end- and mid-points via:

1. Menu

1. Select the function 'Draw > Arc > Startpoint, Endpoint,
Midpoint'

2. Move the cursor to the start point and press LC.
3. Move the cursor to the end point and press LC.
4. Move the cursor to the mid point and press LC.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the start point and press <CR>.
3. Move the cursor to the end point and press <CR>.
4. Move the cursor to the mid point and press <CR>.
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Draw an Arc Using Three Arc-Points.

Command: BOGEN2
Code: 153
Parameter: XS,YS; XB,YB; XE,YE - Inputs are
made sequentially.
Example: 153 - Enter parameters as prompted in
the command line.

menu: yes
Symbol: no

-
Abort the function with <Esc>!

Function: Draws an arc from its (S)tart-, (B)Arc and
(E)ndpoint.

1

1

1. Menu

1. Select the function 'Draw > Arc > Start point, Point on arc,
Endpoint'.

2. Move the cursor to the start point and click.
3. Move the cursor to the second point and click.
4. Move the cursor to the end point and click.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the start point and press <CR>.
3. Move the cursor to the second point and press <CR>.
4. Move the cursor to the end point and press <CR>.

The Arc will be calculated automatically and laid across the
three points.
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11
The completed arc through three points. The function allows
you to chain any number of arcs together. Use <Esc> to abort
the function.
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Draw an Arc on a Tangent from an Element.

Command: BOGEN3
Code: 154
Parameter: XE,YE - Inputs are made sequentially.
Example: 154 - Enter parameters as prompted in
the command line.

Menu: yes
Symbol: no

-
Abort the function with <Esc>!

Function: Draws an arc from the last element to the
given (E)ndpoint.

1

1
Draw an arc tangentially from an element via:

1. Menu

1. Select the function 'Draw > Arc > Tangential from an
existing element'.

2. Move the cursor to the end point and click.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the end point and click <Enter>.

The Arc will be calculated automatically and tacked
onto the existing element.
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11
The completed arc from an existing element to a
given (E)ndpoint. The function allows you to chain
any number of arcs together. Use <Esc> to abort the
function.
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Draw an Arc Tangential to Two Elements.

Command: BO2GO
Code: 66
Parameter: GE1; GE2; Radius; <CR>, <N>, <A> -
the inputs are made sequentially.
Example: 66 - Enter parameters as prompted in the
command line.

Menu: yes
Symbol: no

-
Abort the function with <Esc>!

Function: Draws an arc tangential to two drawing
elements (1, 2).

1

1
Draw an arc tangential to two elements via:

1. Menu

1. Select the function 'Draw > Arcs > Tangential to two
elements'.

2. Move the cursor to the first element and press LC.
3. Move the cursor to the second element and press LC. -

Cursor will go to the mid-point.
4. Enter the radius in the command line or confirm the

suggested mid-point.
5. Accept the arc with <CR> or reject the arc with <N> - the

opposite arc will be offered.
6. Accept the arc with <CR> or abort the funtion with <A>.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the first element and press <CR>.
3. Move the cursor to the second element and press

<CR>.
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4. Enter the radius in the command line.
5. Relpy to the prompts with <CR>, <N> or <A> (as

above).
The opposite arc laid tangentially on the existing
elements.

11
The opposite arc laid tangentially on two elements. Use
<Esc> to abort the function.
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Draw a Full Ellipse with all Inputs.

Command: ELLIPSV
Code: 165
Parameter: Large Radius; Small Radius; Angle of
Inclination for Large Axis; - Inputs are made
sequentially.
Example: 66 50,50 100 50 15.

Menu: no
Symbol: no

-
Once an ellipse has been defined, it can be copied
to multiple mid-points simply by clicking.
Abort the function with <Esc>!

Function: Draws a full ellipse.

Note: Dependant on your machine, ellipse may have
to be cut as Lines (Vectors) or Arcs. For this reason
ncCAD32 offers both construction options.

1

1
Draw an ellipse from the command line:

1. Enter the command or code in the command line.
2. Move the cursor to the mid-point and press <CR>.
3. Enter the size of the large axis.
4. Enter the size of the small axis.
5. Enter the angle of inclination for the large axis.
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Drawing Full-Ellipses with Lines.

Command: VELLIP
Code: no
Parameter: Mid-point; Start-point; Dialog input ; -
Inputs are made sequentially.
Example: VELLIP; Start-point; Dialog.

Menu: yes
Symbol: no

-
Once an ellipse has been defined, it can be copied to
multiple mid-points simply by clicking.
Abort the function with <Esc>!Function: Draws a full ellipse with lines.

1

1
Draw an ellipse via:

1. Menu

1. Select the function 'Draw > Ellipse > Ellipse from
vectors'.

2. Move the cursor to the mid-point and press LC.
3. Enter the ellipse's values in the dialog.
4. Click 'Apply'.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the mid-point and press <CR>.
3. Enter the ellipse's values in the dialog.
4. Click 'Apply'.
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11
This dialog is for defining the ellipse. Click the 'apply' button
to draw the ellipse.
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Drawing a Full Ellipse from Arcs.

Command: BELLIP
Code: no
Parameter: Mid-point; Start-point; Dialog input ; -
Inputs are made sequentially.
Example: VELLIP; Start-point; Dialog.

Menu: yes
Symbol: no

-
Once an ellipse has been defined, it can be copied to
multiple mid-points simply by clicking.
Abort the function with <Esc>!Function: Draws a full ellipse with arcs.

1

1
Draw an ellipse via:

1. menu

1. Select the function 'Draw > Ellipse > Ellipse from
arcs.

2. Move the cursor to the mid-point and press LC.
3. Enter the ellipse's values in the dialog.
4. Click 'Apply'.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the mid-point and press <CR>.
3. Enter the ellipse's values in the dialog.
4. Click 'Apply'.
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11

This dialog is for defining the ellipse. Click the 'apply' button to draw the ellipse.
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Draws Tangents to an Arc or Circle.

Command: TANPK
Code: 57 1
Parameter: XP,YP; Element - Inputs are made
sequentially.
Example: 57 1; Cursor to Startpoint; <CR> Cursor
tof Element; <CR>.

Menu: yes
Symbol: no

-
Abort the function with <Esc>!

Function: Draws a tangent from a (P)oint on a circle
or an arc.

1

1
Draw a tangent via:

1. Menu

1. Select the function 'Draw > Tangents > Point/Circle'.
2. Move the cursor to the start point and press LC.
3. Move the cursor to the circle/arc and press LC.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the start point and press LC or <CR>.
3. Move the cursor to the circle/arc and press LC or <CR>.

The Tangent will be laid against the circle.
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11
The tangent will be laid from the start point to the circle/arc.
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Draw Tangents Between Two Circles.

Command: TAN2K
Code: 46
Parameter: E1; E2 - Inputs are made sequentially.
Example: 46; Cursor to first circle; <CR> Cursor to
second circle; <CR>.

Menu: yes
Symbol: no

-
Abort the function with <Esc>!

Function: Draws a tangent from one circle (E1) to
another circle (E2). A selection allows you to choose
between four different tangents.

1

1
Draw a tangente via:

1. Menu

1. Select the function 'Draw > Tangents > 2 Circles'.
2. Move the cursor to the first circle and press LC.
3. Move the cursor to the second circle and press LC.
4. Select tangent with <A> (or spacebar) - press LC.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the first circle and press <CR>.
3. Move the cursor to the second circle and press <CR>.
4. Select tangent with <A> - press <CR>.

Use <A> or the spacebar to toggle between the four
available options for setting the tangent on the circles.
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11
The tangent can be laid inside or outside. Press <CR> or
click the mouse and the Tangent will be drawn.

12
The tangent can be laid indside or outside. This is the
outside variant. You can switch between the variants
with <A>.
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Drawing Tangential Construction Lines.

Command: TANPK
Code: 57 2
Parameter: Element; Angle - Inputs are made
sequentially.
Example: 57 2; Cursor to element; <CR>; 60;
<CR>.

Menu: yes
Symbol: yes

-
Abort the function with <Esc>!

Function: Draws a construction line tangential to a
circle or an arc.

1

1
Draw a tangential construction line via:

1. Menu

1. Select the function 'Draw > Tangents > Point/Circle'.
2. Move the cursor to the circle/arc and press LC
3. Use the mouse to move the tangent to the correct

position (Rotational); confirm with a click.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the circle/arc and press <CR>.
3. Enter the tangent's angle and press <CR>.

The Tangent will be laid on the circle.
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11
The tangential construction line will be laid on the
circle/arc at the given angle.
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Filleting the Corner of Two Elements.

Command: VER
Code: 76
Parameter: Corner point; Radius - Inputs are made
sequentially.
Example: 76; Cursor to corner point; <CR>; 60;
<CR>.

Menu: yes
Symbol: yes

Function: Draws a fillet arc on the corner of two
elements.

A fillet can be undone via the menu.

1

1
Draw a fillet via:

1. Menu

1. Select the function 'Draw > Fillet'.
2. Move the cursor to the corner and press LC.
3. Enter the radius and confirm with a mouse click.

2. Symbol

1. Select 'fillet'.
2. Move the cursor to the corner and press LC
3. Enter the radius and confirm with a mouse click.

3. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the corner and press <CR>.
3. Enter the radius and confirm with <CR>.



ncCAD32

Rev.1.2 Page: 80Date: 2018-5-7

Entering Simple Text.

Command: TEXT
Code: 75
Parameter: Start point; Text - Inputs are made
sequentially.
Example: 75; Start point; Example text.

Menu: yes
Symbol: no

-
Texts are drawn based upon pre-defined
parameters. These paramters are accessible via a
Dialog, which you can reach through the menu item
'Text > ncCAD Text > Parameter ..'.

Function: Draws simple text in a drawing.

- ncCAD32 also offers the option to use 'True Type'
texts to create layout texts.

Note: texts should always be written with an external
contour. Internal elements should be held with
cutting bridges.

1

1
Draw a text via:

1. Menu

1. Select the function 'Text > ncCAD Text > input'.
2. Move the cursor to the start point and LC.
3. Enter the text and press <CR>.

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the start point and press <CR>.
3. Enter the text and press <CR>.
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11
This dialog allows the presets for entering text
to be changed. Call the dialog through the
menu or the command line with the command
(TEXTP), or code (75).
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Entering True Type Texts.

Command: no
Code: 420
Parameter: Dialog; Start point - Inputs are made
sequentially.
Example: 420; Dialog; 40,40.

Menu: yes
Symbol: no

-
Texts are entered into a dialog and drawn at the
given location.

Function: Draws layout texts in your drawing using
true-type fonts.

Note: texts should always be written with an external
contour. Internal elements should be held with
cutting bridges.

1

1
Draw a text via:

1. Menu

1. Select the function 'Text > TrueType Text > Text input'.
2. Fill out the dialog and click 'apply'.
3. Move the cursor to the start point and LC.

2. Command Line

1. Enter the command or code in the command line.
2. Fill out the dialog and click 'apply'.
3. Move the cursor to the start point and <CR>.
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11
This dialog allows the presets for
entering text to be changed. Call
the dialog through the menu or
the command line with the
command (TEXTP), or code (75).
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Printing
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Printing the Drawing?

There is a dialogue box with options with various
options for setting-up your printer when printing
your drawing.
There is a preview of your drawing to the left. If
there is no preview here, check the 'current' layer
checkbox.

Make all settings for your printer and print your
drawing out.

1

2

1

Use the buttons to access the printer setting for your system's printer. The 'Preview' button re-draws
the drawing. Right-click to leave the dialogue box.
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2
As well as settings for the print format, you can also select
the Line types and colours and determine the Print quality.

21
Make settings about the line types and colours here. The
print quality can be set in another frame.
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22
Make settings about the print quality here.
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The Editing Functions.
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Different Ways of Drawing Elements.

Elements can be edited in different ways. You can
access the function via the menu, entering the
code in the command line, or in part using the icon
bar. Before you attempt to edit an elements, you
must mark, or identify, one or more elements.

The editing functions can be accessed from the
menu panel [1] and in part using the icon bar [2].

1
2

3

1
Use the menu to access an edit function. The relevant elements must
be identified first.

2
Some functions can be activated using the icon bar. The required elements must be
selected as before.
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3
These elements represent the foundation for describing the edit
functions. The mode of operation shall be explained through them.
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Copy/Turn Elements.

Copy in a row/column:

Select menu pooint [1] 'Copy/Turn'
LC in the drawing window; selecet 'Row/Column' in
the selection dialog.
Select the 'Row' or 'Column' tab.
Enter the number of rows or columns and the
offsets between the parts.
Click 'Apply'.

Copy around a center:

Select menu item [1] 'Copy/ Turn'.
LC on the center; select the 'Turn' tab in the
selection dialog.
Select the 'Quantity/Diff' or 'Quantity/Angle' tab.
Enter the quantity of parts and either the difference
angle or the total angle.
Click Apply.

The program also allows for freehand copying. This
function is described in the 'Freehand copying'
chapter.

This function allows elements to be copied in rows,
columns or a grid, or around a reference (center)
point.
The element(s) to be copied must be identified
before copying.

1

2

1
Select the menu item 'Copy/Turn'. The relevant elements must be
identified first.
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2
In this picture the small circle to the right has been identified, and is
to be copied in multiple rows. To do this, select 'Copy/Turn' and LC
the reference point.
Select the copying method by choosing the tab 'Row/Column' or
'Turn'.

21
Select the 'Rows' tab and
enter the number of rows, and
the offset between parts. Click
'Apply' to copy the circle the
given number of times into
rows. There are separate
options for 'Columns' and
'Grid'.
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22
This is the selection dialog for
columns. There are separate
options for 'Rows' and 'Grid'.

23
This is the selection dialog for
a grid. There are separate
options for 'Rows' and
'Columns'.
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24
The result of copying in multiple rows. To copy into columns, work
in the same manner, but use the 'Columns' option.

25
This is the selection dialog for
copying around a center with
an offset angle. Enter the
number of elements and the
difference angle between
each copy. There is a
separate option for 'Total
angle'.
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26
This is the selection dialog for
copying around a center with a
total angle. Enter the number
of elements and the total
angle. There is a separate
option for 'Difference angle'.
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Free Move.

Free-moving drawing elements:

Select menu item [1] 'free move'
LC in the drawing window; the element will be 'tied'
to the cursor.
Move the element to the required new position.
LC to 'release' the element, placing it in its new
location.

Move via Dialog:

Select menu item [1] 'Copy/Turn'
LC in the drawing window; select 'Move/Copy' from
the selection dialog.
Select the 'Move' button.
enter X/Y values.
Click apply.

This function allows you to move elements around
the drawing. You must first mark the element; it
must be identified.

1

2

1
Select the 'Free Move' menu item to move with the mouse, or
'Copy/Turn' to move using a dialog.
The relevant elements must be identified first.
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2
The small circle to the right has been identified and is to be moved.
Select the 'Free Move' option and LC the reference point.
Move the circle to the required position and LC to place it.

21
When moving, an offset line between the reference point and the
new position will be shown as a check. LC to position the element.

22
The result of moving.
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23
Select the 'Move/Copy' tab,
mark the 'Move' button and
enter the X/Y position. Click
'Apply' to move the circle to the
given coordinates.
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Free Copy.

Free-copying drawing elements:

Select menu item [1] 'Free copy
LC in the drawing window; the element will be 'tied'
to the cursor.
Move the element to the required new position.
LC to 'release' the element, copying it to its new
location.

Free copy via Dialog :

Select menu item [1] 'Copy/Turn'
LC in the drawing window; select 'Move/Copy' from
the selection dialog.
Select the 'Copy' button.
enter X/Y values.
Click apply.

This function allows you to copy geometric
elements in the drawing. You must first mark the
element; it must be identified.

1

2

1
Select the 'Free Copy' menu item to move with the mouse, or
'Copy/Turn' to move using a dialog.
The relevant elements must be identified first.
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2
The small circle to the right has been identified and is to be copied.
Select the 'Free Copy' option and LC the reference point.
Move the circle to the required position and LC to copy it.

21
When copying, an offset line between the reference point and the
new position will be shown as a check. LC to place the element.

22
The result of copying.
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23
Select the 'Move/Copy' tab,
mark the 'Copy' button and
enter the X/Y position. Click
'Apply' to copy the circle to the
given coordinates.
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Scaling

Scaling geometric elements:

Select menu item [1] 'Scaling'.
LC on the drawing window to call a dialog box.
Enter the scaling factor.
Click 'Apply'; the elements is rescaled.

The function allows an element's size to be
increased or reduced. The relevant element must
be identified first.

1

2

1
Select the 'Scaling' menu item.
The relevant elements must be identified first.
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2
The small circle to the right has been identified and is to be rescaled.
Select the 'Scaling' option and LC the element.
a dialog box appears for you to enter the scaling factor.
Enter the value and click 'Apply'.

21
Enter the scaling factor for the increase or reduction in
size; the element will be re-drawn.

22
The result of scaling.
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Mirror

Mirroring geometric elements:

Select the menu item [1] 'Mirror'
Click the reference point.
Click the start point of the mirroring axis.
Click the end point of the mirroring axis.

The function can also be accessed via the
quick-keys.

Free copy via Dialog :

Select menu item [1] 'Copy/Turn'
LC in the drawing window; select 'Mirroring' from
the selection dialog.
Select the axis.
Click apply.

Freies Spiegeln über Dialog [31]:

Menüpunkt [1] 'Kopieren/drehen' wählen.
MT auf Zeichenfeld; im Auswahldialog Tab
'Spiegeln' wählen.
Achse wählen.
Übernehmen drücken.

This function allows you to mirror geometric
elements as required. First give a mirroring axis by
defining its start and end point. A reference point is
given as a construction point which can be useful
when mirroring horizontally or vertically.
The requirement for this is that an element has
been selected first.

1

2
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1
Select the 'Mirror' menu item.
The relevant elements must be identified first.

2
Both circles have now been identified and are to be mirrored. To do
this, select the 'Mirror' menu item and click the reference point. The
cursor 'runs' along the horizontal or vertical axis.
Then click the start and end point. The elements are shown mirrored
along the mirroring axis. The start and end points are freely selectable
and are not bound to the reference point!

3
The mirrored element.
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31
Select the tab 'mirror', select
the axis. Clicking on 'apply' will
copy the part at the marked
position.
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Clipboard

Copying to the clipboard:

Select menu item [1] 'Copy to Clipboard'.
Click at reference point.

The function can also be called using the
quick-keys <Ctrl><Insert> or <Ctrl><C>.

Pasting from the clipboard:

Select menu item [1] 'Paste from Clipboard'.
Click the reference point.

The function can also be called using the
quick-keys <Ctrl><Insert> or <Ctrl><V>.

An element can be copied to the clipboard for use
any number of times in the drawing. The copy is
related to a reference point you set when you save
to the clipboard.
You must first mark the element; it must be
identified.

1

2

1
Select the menu item 'Copy to the Clipboard', or 'Paste from the
Clipboard' respectively.
The relevant elements must be identified first.
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2
Both circles have been identified for copying to the clipboard
here. Select the menu item 'Copy to clipboard' [1] and click the
reference point.

To paste, select the 'Paste from clipboard' menu item [1] and
click to copy the element, from its reference point, at the cursor
position.
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Display Equidistants.

This screen is accessed via the Menu selection
'Edit' - 'Draw equidistants'.

After creating an equidistant, check the contours
for any overlaps in close spaces, and correct
manually.

Equidistants are construction lines with an encircling
clearance to a contour. This clearance is usually for
the cutting tool. When displayed you receive extra
information about the amount of material being used
productively.

1
2

2
In this example equidistants have
been placed on the external
contour. The corners are rounded.
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1
The 'All Contours' tab allows you to check the drawings. The
bottom pane shows the calculated equidistants' values.
Switch to the 'Parameter' tab to make settings for the
calculation.

The functions of the buttons in the header panel are:

Redraw all.
Display only the current contour.
Create equidistants on all contours.
Create equidistants on only the current contours.
Display all geometric elements of the current contour.

11
This tab allows you to quickly enter the settings for
equidistants.
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Hatch An Area.

Command: SCHRAF
Code: 28
Parameters: Hatch offset in mm; hatch angle +/-;
layer number; area identifier (area=2); start point;
end point; hatch area; end - entry is sequential
Example: 28 5 -45 2 2 ...

Menu: yes
Icon: no

Function: The selected area is hatched on the
entered layer.

1

1
Hatch a selected area:

1. Menu

1. Function 'Draw > Hatch > Enter values in
the command line.

2. Cursor to start point, click.
3. Cursor to end point, click.
4. Cursor to hatch area, click.

2. Command line

1. Enter command or code and parameters in
the command line.

2. define area.
3. Finalize area selection 'E'.
4. Move to hatch area.
5. Finalize function 'E'.
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Drawing And Resolution Of Splines.

Command: SPLINE
Code: 77
Parameters: Start point; support points 'E',
resolution, 'E', save - entry is sequential
Example: 77, 1, <click, click,...>, E, 7, 10, E,
<Enter>

Menu: yes
Icon: no

When entering the curves the spline points are
identified through circles which can then be moved
using entries in the command line.

Function: A spline is drawn using the input or
definition of support points and can be dissolved into
any number of vectors and saved as a DXF file.

If the drawing is saved as a ZEW file the spline
remains in its entirety; single points are however
then unidentifiable.

1

1

A spline curve as a partial contour in a component. Resolved into lines and saved as a DXF, the
individual points can then be used as geometric drawing points for further editing.

Drawing a spline:

1. Menu
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1. Function 'Draw > Spline > Enter values in the command line.
2. Cursor to start point, click.
3. Cursor to support points, click at each.
4. End spline with 'E' in the command line.
5. Edit spline; set resolution '7' in the command line.
6. Save spline <Enter>.

2. Command line

1. Enter command or code and parameters in the command line.
2. Cursor to support points, click at each.
3. End spline with 'E' in the command line.
4. Edit spline; set resolution '7' in the command line.
5. Save spline <Enter>.
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Giving Dimensions in your Drawing.

When dimensioning you workpiece, you should
consider the arrangement of the dimensions
carefully and then use the relevant menu items to
locate the dimensions on your drawing in the
correct order.
When placing the first dimensioning lines, leave
yourself enough space to place any others you will
need.

Important: After aligning a dimension, you must
press <CR> or LC to place the dimensionins label!

Dimensioning with and without numbers is done in
exactly the same way, and so this procedure will
only be described once (for dimensioning with
numbers).

ncCAD32 allows you to dimension your drawings
according to the standard rules. The programs
menus will help you dimension your drawing
correctly.

1

1
This workpiece is to be dimensioned between two
reference lines. Menu items 1. Dimensioning and 2.
Dimensioning, last Dim., Circle and Arc will be
required to align the dimensioning.
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Dimensioning a Length.

Command: BEM2T (BEM2)
Code: 54 (34)
Parameter: 1.MBP; 2.MBP; ML - Inputs are made
sequentially.
Example: 54; 1.MBP; 2.MBP; ML; <CR>; <CR>.

Menu: yes
Symbol: yes

-
The codes in brackets apply for dimensioning
without measurements.

Function: Lays a dimensioning line (ML) across a
length between a first dimensioning limit point (MBP)
and a second dimensioning limit point.

1

1
Lay a dimensioning line via:

1. Menu

1. Select the function 'General > Dimensioning > XY
Dimensioning > With Measurements'.

2. Move the cursor to the first dimensioning limit point and LC.
3. Move the cursor to the second dimensioning limit point and LC.
4. Move the cursor to the dimensioning line's position and LC.
5. LC!

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the first dimensioning limit point and press

<CR>.
3. Move the cursor to the second dimensioning limit point and

press <CR>.
4. Move the cursor to the dimensioning line's position and press

<CR>.
5. Press <CR>!
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Dimensioning Using a Reference Line.

First set a first dimensioining between two limiting
points. A reference line will be laid on the second
point and (virtually to begin with) on the first limiting
point.

Command: no
Code: no
Parameter: 1.MBP; 2.MBP; ML - Inputs are made
sequentially.

Menu: yes
Symbol: no

-
Set a second dimensioning line relating to the
same first limiting point.

Command: no
Code: no
Parameter: 2.MBP

Menu: yes
Symbol: no

-
Place last dimensioning line; the reference line on
the first limiting point will finally be displayed along
with all dimensioning lines related to it.

Command: no
Code: no
Parameter: 2.MBP

Menu: yes
Symbol: no

-

Function: Lays dimensioning lines (ML) across a
length between two limiting points, whereby a
reference line is drawn from the first limiting point.
The sequence must be adhered to when adding a
dimensioning line in order to retain the relation to the
reference line.

1
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1
Laying a dimension on a reference line.
Set the first dimension via:

1. menu:

1. Select the function 'General > Dimensioning > XY Dimensioning > First
Dimensioning'.

2. Move the cursor to the first dimensioning limit point and LC.
3. Move the cursor to the second dimensioning limit point and LC.
4. Move the cursor to the dimensioning line's position and LC.
5. LC!

After the first dimensioning line, a second dimensioning line can be
related to the same reference line.

2
Setting a dimensioning line on a reference line.
Add a second dimensioning line via:

1. Menu:

1. Select the function 'General > Dimensioning > XY Dimensioning >
Second Dimensioning'.

2. Move the cursor to the second dimensioning limit point and LC.
3. LC!

After the second dimensioning line, a final dimensioning line must be
added to the reference line to close it.
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3
Laying a dimensioning line on a reference line.
Lay a final dimensioning line via:

1. Menu:

1. Select the function 'General > Dimensioning > XY Dimensioning >
Final Dimensioning'.

2. Move the cursor to the final dimensioning limit point and LC.
3. LC!
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Dimensioning Between Two Points.

Command: BEM1T (BEM1)
Code: 53 (33)
Parameter: 1.MBP; 2.MBP; ML - Inputs are made
sequentially.
Example: 53; 1.MBP; 2.MBP; ML; <CR>; <CR>.

Menu: yes
Symbol: yes

-
The codes in brackets apply for dimensioning
without measurements.

Function: Lays a dimensioning line (ML) between a
first limiting point (MBP) and a second.

1

1
Lay a dimensioning line via:

1. menu

1. Select the function 'General > Dimensioning > Point
Dimensioning > With Measurements'.

2. Move the cursor to the first dimensioning limit point and LC.
3. Move the cursor to the second dimensioning limit point and

LC.
4. Move the cursor to the dimensioning line's position and LC.
5. LC!

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the first dimensioning limit point and

press <CR>.
3. Move the cursor to the second dimensioning limit point and

press <CR>.
4. Move the cursor to the dimensioning line's position and press

<CR>.
5. Press <CR>!
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Dimensioning a Circle.

Command: BEMK
Code: 43
Parameter: Circle; ML - Inputs are made
sequentially.
Example: 43; Identify circle; ML; <CR>; <CR>.

Menu: yes
Symbol: yes

-

Function: Lays a dimensioning line (ML) on a circle.

1

1
Lay a dimensioning line via:

1. Menu

1. Select the function 'General > Dimensioning > Circles'.
2. Move the cursor to the circle and LC.
3. Move the cursor to the dimensioning line's position and LC.
4. LC!

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the circle and press <CR>.
3. Move the cursor to the dimensioning line's position and press <CR>.
4. Press <CR>!
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Dimensioning an Arc.

Command: BEMB
Code: 63
Parameter: Arc; ML - Inputs are made sequentially.
Example: 63; Identify Arc; ML; <CR>; <CR>.

Menu: yes
Symbol: yes

-

Function: Sets a dimensioning line (ML) on an arc.

1

1
Lay a dimensioning line via:

1. Menu

1. Select the function 'General > Dimensioning > 'Arcs'.
2. Move the cursor to the circle and LC.
3. Move the cursor to the dimensioning line's position and LC.
4. LC!

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the arc and press <CR>.
3. Move the cursor to the dimensioning line's position and press

<CR>.
4. Press <CR>!
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Dimensioning an Angle.

Command: BEMW
Code: 64
Parameter: 1.HL,1.GP; 1.HL,2.GP; 2.HL,1.GP;
2.HL,2.GP; ML - Inputs are made sequentially.
Example: 64; 1.HL,1.GP; 1.HL,2.GP; 2.HL,1.GP;
2.HL,2.GP; ML; <CR>; <CR>.

Menu: yes
Symbol: yes

-

Function: Sets a dimensioning line (ML) on an angle.
The angle is limited by two reference construction
lines (HL) which are defined by a first and second
point in the drawing (GP). The ML can be located
inside or outside the arc, or be placed as an opposite
angle.

1

1
Lay a dimensioning line via:

1. menu

1. Select the function 'General > Dimensioning > 'Angle'.
2. Move the cursor to the first HL, first GP and LC.
3. Move the cursor to the first HL, second GP and LC.
4. Move the cursor to the second HL, first GP and LC.
5. Move the cursor to the second HL, second GP and LC.
6. Move the cursor to the dimensioning line's position and LC.
7. LC!

2. Command Line

1. Enter the command or code in the command line.
2. Move the cursor to the first HL, first GP and Press <CR>!.
3. Move the cursor to the first HL, second GP and Press <CR>!.
4. Move the cursor to the second HL, first GP and Press <CR>!.
5. Move the cursor to the second HL, second GP and Press

<CR>!.
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6. Move the cursor to the dimensioning line's position and Press
<CR>!.

7. Press <CR>!

The dimensioning line can also be placed internally on the angle.

2
Now for an internal dimensioning line.

An opposite angle will also be shown to give the full picture.

3
We have used the same subject here to illustrate the use of an
opposite angle, despite the fact that it is not a sensible place to use
it.
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Use drawing points to determine a dimension.

In the submenu 'General', 'Measure' you will find
the following functions for determining sizes:

Distance between two points in X and Y direction
(69, ABM).
Polar distance between two points (79, ABP).
Surface area of a contour (89, FLB).
Size of an enclosing min/max box (219, MINMAX).
Offsets and sizes of one or two circles.

The functions use codes (in brackets) which when
expanded with drawing points allow calculation of
the values, and display the results in the command
line.

By defining drawing points you can use existing
information to calculate certain dimensions of
contour elements in your drawing..

1

1

When measuring circles you can select one or two circles. If you select two circles then the distance
between them will be displayed as well as the circle parameters for both. If both points are on the same
circle then only the data for this circle will be displayed.



Symbols

Symbols

ncCAD32

Rev.1.2 Date: 2018-5-7Page: 123

Create And Use Symbols.

In the submenu 'General', 'Symbols' you will find
the following functions for using symbols:

Create symbol (37, SYMD).
Call symbol (38, SYMA).
Symbol 2 points (48, SYMP).
Symbol angle (58, SYMMW).
Output: places a symbol in a drawing.
Search: finds the symbol nearest the cursor.
Delete: delete a symbol identified using the
(search) command.

The functions use codes (in brackets) which when
expanded with positions create or display symbols.

ncCAD32 gives you the option to use symbols as
markings in your drawings. Symbols can be drawn to
your requirements in the program, and saved
separately as .SYM files. Symbols can then be
scaled and added anywhere on your drawing.

Symbols are saved independently in ZEW files and
are not considered during processing. Save
drawings with symbols as DXF files and the symbols
will be deconstructed to identifiable elements.

1

1
Draw a symbol to your needs and labeling
requirements, then save the symbol using the
menu item 'General', 'Symbols', 'Create symbol'.
Define the symbol using a min/max box defined
by start and end points, then name and save your
symbol as a separate .SYM file.
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Macros As Predefined Drawings Or Drawing Elements.

The 'Draw' menu contains a separate block for
macros, in which macros are sorted by purpose
ready for direct selection.

General macros
Macros for torch cutting
Chain cuts
Grid
Macros for perforated sheets

Macros can also be added to the icon bar so that
frequently used macros can be called instantly.
Right-click the blank element in the menu panel to
access a selection menu to manipulate the icon
bar.

Macros are predefined drawings or drawing
elements which can be adjusted to suit your
recurring needs. They allow you to create and insert
complex shapes like long holes, bolt hole circles,
hole rows, notches, etc. quickly and easily.

Macros can also be executed by entering their
names in the command line. The required values or
steps will be prompted sequentially in the command
line. It should be noted that an element's position or
the start point for the macro must first be set using
the cursor. For example to add a beveled edge, the
cursor must first be set to the relevant corner.

1
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1
The 'Draw' menu contains the macros grouped by
function, these can be called in submenus.

After selecting a macro you should select its start
point then enter its parameters in the pop-up
dialog which appears.

11
This dialog shows the selected
macro. The drawing to the right
shows the general form with the
variable parameters identified. The
drawing to the left shows a preview
based on the current parameters.
Enter the values you require and
'confirm'.
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Prepare Your Drawing For NC Processing.

'NC Processing' allows you to take all necessary
steps to prepare your drawing for passing to a
production module:

Edit contour - select contours and contour
elements and move them to different layers.

Define contour.
Select contour.
Delete duplicate elements.
Hide open contours.

Sort contours.
Sort inner contours.
Post-processor
Call NC module with current layer.
Call NC module with multiple layers.
Nest

After drawing a contour you may need to take further
steps before it's ready to be processed. Production
modules could be stamping or cutting modules which
work with the post-processor to create the required
NC code.

1

1

The 'NC Processing' menu allows you to take all necessary steps to prepare your drawing for passing
to a production module:

The submenu 'Select contour' allows you to select an area containing multiple contours to be moved to
a shared layer.

Sort contours: ncCAD32 automatically sorts your workpiece's contours into outer and inner contours. If
contours should be cut as inner contours because the outer contour is defined by a fitting, then make
the relevant setting under 'Sort as inner contours'.
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11
You can set the selection criteria for
transferring the contours in the
selected area in this dialog. Mark
the selection boxes and enter the
layer number in the bottom-left
field, then click 'confirm'.

12
All post-processors installed on
your system are listed in this dialog.
Select a post-processor from the
list and click 'confirm'. The
subsequently created NC program
will be suited to a specific cutting
machine according to your
post-processor selection.
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Analyzer
Tool for analyzing a DXF drawing's geometric shapes.

Close gaps 43
Combine 46
Contour elements 43
Delete elements 43
Element values 44
Find elements 45
Functions 42
General 41
Pen/Line type 44

Arc
The arc as part of a circle (segment).

Center 60
Menu 15
Points (through 3) 61
Tangential (2 elements) 65
Tangential 63

Circle
Circles as closed elements.

Combine 17
Divide 17
Elements (from three) 57
Elements (from two) 56
Fit 17
Menu 14
Radius 55
Separate 17
Symbol 30
Through a point 58
Trim 17

Command line
Input line for text commands when drawing.

Display entry format 5
Entry format 5
General 4
Shortcuts 6

Command sequence
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The sequential process when drawing geometric elements.

Batch 6
Entry 4
Exit 4
Shortcuts 6
Text mode 4

Construction lines
Construction lines aid when drawing new parts.

Circle 56
Equidistants 106
General 24
Menu 17
Symbol 29
Tangential 76
Tip 29

Coordinates
Position information about cursor and elements.

Polar 5
Triangulation 5
X/Y 5

Corner
A corner joining two elements.

Geometric element
Create 30
Fillet 78
Filleting 30

Cursor
The cursor is the foundation tool when drawing and selecting.

General 3
Info 4
Polar coordinates 5
Position 6
Symbol 7
Triangulation 5
X/Y coordinates 5

Dimensioning
Dimensioning a drawing according to general dimensioning rules.

Angle 119
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Arc 118
Circle 117
Dimensioning arrows 18
General 111
Line 112
Menu 18
Parameter 21
Points 116
Reference line 113

Drawing Board
The 'drawing board' is the work screen where you create your workpieces.

Cursor 7
General 3
Mouse buttons 8

Drawing
'Drawing' describes a workpiece saved in a file.

Area scale 17
Create new 9
Display 3
Drawing board 3
Export 46
Function 48
General 1
Layers 21
Load 9
Print 84
Symbol 29
Zoom window 11
Zoom 3

DXF
DXF is a standardized file format for CAD drawings.

Analyzer 41
Checking 31
Import 9
Load 31
Save 31

Edit functions
Functions with which existing items can be manipulated.

Clipboard 104
Copy/turn 88
Free copy 96
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Mirror 101
Move 93
Scale 99

Element
Signifies a drawing element.

Geometric element
Geometric points 7
Clean-up 41
Selection 26

Ellipse
Ellipses as closed elements.

From arcs 70
From lines 68
Function 67
Menu 10

Engraving
Highlight workpieces  with engraving.

Function 108
Menu 14

Entry format
Format for entering drawing commands as text strings.

General 4
Polar coordinates 5
Shifting 5
Triangulation 5
X/Y coordinates 5

Equidistants
A line with a constant distance to an original line.

Area calculation 108
General 106
Margin lines 108
Menu 17
Parameter 108

External Programs
Integrate external programs for instant access.

Insert 10
List 10
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Files
Files with various contents in given formats.

DWG Parameters 40
DXF Parameters 40
Formats 31
Load 9
Management 31
Parameters 38
Save 9
ZEW 31

Fillet
Rounding of two elements.

Function 78
Menu 14
Remove 17
Symbol 30

Format Line
The format line shows current settings for drawing operations.

General 4

Formats
Set rules for colors, lines and pens.

Define 11
Grid 19
Text 81
True-type text 83

Function Keys
Allocate preferred commands to the f-keys.

Allocation 20
Menu 18

Geometric elements
Geometric elements combine to make you workpiece.

Copy 96
Fit 29
Info 4
Mirror 99
Move 93
Points 7
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Selection 26
Trim 29

Geometric points
Geometric points are single points on drawing elements.

Info 4
Tip 4
Values 26

Grid
Markings on the drawing board used as a drawing aid.

Dialog 19
Menu 18
Show/hide 4
Tip 4

Icon bar
Single clicks to begin drawing operations.

General 26
Properties 28
Selection menu 28

Layers
A level in your drawing (layer) for segmenting drawing content.

Combine 13
Create 22
Current 23
Delete contents 22
General 21
Management 22
Remove 22

License
Authorization and use of the program through a dongle.

Authorization 13
Dongle 13
License file 13
License management 13

Line type
Allocate functions to a line using its style.

Display 4
Functions 12



ncCAD32

Rev.1.2 Page: 134Date: 2018-5-7

Menu 11
Printer 85
Quick selection 4

Lines
Lines are the visible shapes of elements.

Colors 18
Combine 17
Current 4
Divide 17
Fit 17
Function 52
Menu 11
Pen type 11
Printer 85
Separate 17
Spline 109
Symbol 30
Trim 17
Types 11

Macros
Using predefined drawing segments or commands in your drawings.

Chain cuts 123
Dialogs 125
General 123
Grid 123
Menu 14
Perforated sheets 123
Symbols 31
Torch cutting 123

Measuring
Detail information about your drawing.

Areas 121
Distances 121
General 121
Menu 18

Menu bar
The menu bar serves the navigation and setup of your software.

General 8
Introduction 2

Mouse
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The mouse as your main tool.

Buttons 8
General 6
Scroll wheel 3

NC processing
Preparatory work for passing your drawing to the production module.

Contour selection 127
General 125
Inner contours 126
Menu 21
Outer contours 126
Post-processor 127
Production module 125

Origin
The orig•in is the reference point for drawing operations.

Current 6
Define 51
Function 50
Menu 11
Orig•in 0 4
Orig•in 1 3
Selection 51

Printer
Print dialog for the printer.

Colors 85
Lines 85
Preview 83
Quality 86
Settings 84
Setup 85

Rectangle
Rectangles as line groups.

Function 54
Menu 14
Symbol 29

Selection
Selection of geometric element.

Contour groups 26
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Elements (Multiple) 26
Function 26
General 24
Menu 11
Symbol 29

Settings
Program and system settings.

Authorization 13
Colors 12
Drawing size 12
Language selection 13
License 13
Measuring system 13
Paths 13
Program starter 13
Scale 13

Spline
Harmonized polygon lines as contour elements.

General 109
Load 32
Menu 14
Resolution 41

Start point
Set the start point for beginning your drawing operations.

Define 52
Function 51
Line

Status bar
The status bar contains important information about your drawing.

Current orig•in 6
General 6
Layer number 6

Tangents
Tangents from arcs or circles.

Construction line 76
Elements (from two) 74
Function 72
Menu 16
Symbol 30
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Text
Text as ncCAD texts or true-type texts.

Menu 17
Parameters 81
Simple 79
Symbols 122
True-type settings 83
True-type 81

Undo
Take back an erroneous command.

Menu 18
Parameters 20
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A Allocation (Function Keys) 20
Analyzer (DXF) 41
Angle (Dimensioning) 119
Arc (Dimensioning) 118
Area calculation (Equidistants) 108
Area scale (Drawing) 17
Areas (Measuring) 121
Authorization (License) 13
Authorization (Settings) 13

B Batch (Command sequence) 6
Buttons (Mouse) 8

C Center (Arc) 60
Chain cuts (Macros) 123
Checking (DXF) 31
Circle (Construction lines) 56
Circle (Dimensioning) 117
Clean-up (Element) 41
Clipboard (Edit functions) 104
Close gaps (Analyzer) 43
Colors (Printer) 85
Colors (Lines) 18
Colors (Settings) 12
Combine (Circle) 17
Combine (Lines) 17
Combine (Layers) 13
Combine (Analyzer) 46
Construction line (Tangents) 76
Contour elements (Analyzer) 43
Contour groups (Selection) 26
Contour selection (NC processing) 127
Copy (Geometric elements) 96
Copy/turn (Edit functions) 88
Create (Corner) 30
Create (Layers) 22
Create new (Drawing) 9
Current (Origin) 6
Current (Layers) 23
Current (Lines) 4
Current orig•in (Status bar) 6
Cursor (Drawing Board) 7

D Define (Start point) 52
Define (Formats) 11
Define (Origin) 51
Delete contents (Layers) 22
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Delete elements (Analyzer) 43
Dialog (Grid) 19
Dialogs (Macros) 125
Dimensioning arrows (Dimensioning) 18
Display (Line type) 4
Display (Drawing) 3
Display entry format (Command line) 5
Distances (Measuring) 121
Divide (Lines) 17
Divide (Circle) 17
Dongle (License) 13
Drawing board (Drawing) 3
Drawing size (Settings) 12
DWG Parameters (Files) 40
DXF Parameters (Files) 40

E Element values (Analyzer) 44
Elements (from three) (Circle) 57
Elements (from two) (Tangents) 74
Elements (from two)  (Circle) 56
Elements (Multiple) (Selection) 26
Entry (Command sequence) 4
Entry format (Command line) 5
Equidistants (Construction lines) 106
Exit (Command sequence) 4
Export (Drawing) 46

F Fillet (Corner) 78
Filleting (Corner) 30
Find elements (Analyzer) 45
Fit (Circle) 17
Fit (Geometric elements) 29
Fit (Lines) 17
Formats (Files) 31
Free copy (Edit functions) 96
From arcs (Ellipse) 70
From lines (Ellipse) 68
Function (Selection) 26
Function (Ellipse) 67
Function (Drawing) 48
Function (Origin) 50
Function (Engraving) 108
Function (Start point) 51
Function (Rectangle) 54
Function (Lines) 52
Function (Fillet) 78
Function (Tangents) 72
Functions (Line type) 12
Functions (Analyzer) 42

G General (Dimensioning) 111
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General (Entry format) 4
General (Icon bar) 26
General (Analyzer) 41
General (Construction lines) 24
General (Format Line) 4
General (Equidistants) 106
General (Layers) 21
General (Selection) 24
General (Macros) 123
General (Drawing Board) 3
General (Cursor) 3
General (Spline) 109
General (Measuring) 121
General (Menu bar) 8
General (Drawing) 1
General (Status bar) 6
General (Mouse) 6
General (Command line) 4
General (NC processing) 125
Geometric points (Element) 7
Grid (Macros) 123
Grid (Formats) 19

I Import (DXF) 9
Info (Geometric elements) 4
Info (Cursor) 4
Info (Geometric points) 4
Inner contours (NC processing) 126
Insert (External Programs) 10
Introduction (Menu bar) 2

L Language selection (Settings) 13
Layer number (Status bar) 6
Layers (Drawing) 21
License (Settings) 13
License file (License) 13
License management (License) 13
Line (Dimensioning) 112
Lines (Printer) 85
List (External Programs) 10
Load (Files) 9
Load (Drawing) 9
Load (Spline) 32
Load (DXF) 31

M Management (Files) 31
Management (Layers) 22
Margin lines (Equidistants) 108
Measuring system (Settings) 13
Menu (Selection) 11
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Menu (Equidistants) 17
Menu (Circle) 14
Menu (Construction lines) 17
Menu (Line type) 11
Menu (NC processing) 21
Menu (Ellipse) 10
Menu (Macros) 14
Menu (Arc) 15
Menu (Spline) 14
Menu (Origin) 11
Menu (Grid) 18
Menu (Function Keys) 18
Menu (Fillet) 14
Menu (Rectangle) 14
Menu (Measuring) 18
Menu (Dimensioning) 18
Menu (Engraving) 14
Menu (Lines) 11
Menu (Tangents) 16
Menu (Text) 17
Menu (Undo) 18
Mirror (Geometric elements) 99
Mirror (Edit functions) 101
Mouse buttons (Drawing Board) 8
Move (Edit functions) 93
Move (Geometric elements) 93

O Orig•in 0 (Origin) 4
Orig•in 1 (Origin) 3
Outer contours (NC processing) 126

P Parameter (Equidistants) 108
Parameter (Dimensioning) 21
Parameters (Text) 81
Parameters (Files) 38
Parameters (Undo) 20
Paths (Settings) 13
Pen type (Lines) 11
Pen/Line type (Analyzer) 44
Perforated sheets (Macros) 123
Points (Dimensioning) 116
Points (Geometric elements) 7
Points (through 3) (Arc) 61
Polar (Coordinates) 5
Polar coordinates (Cursor) 5
Polar coordinates (Entry format) 5
Position (Cursor) 6
Post-processor (NC processing) 127
Preview (Printer) 83
Print (Drawing) 84



ncCAD32

Rev.1.2 Page: 142Date: 2018-5-7

Printer (Lines) 85
Printer (Line type) 85
Production module (NC processing) 125
Program starter (Settings) 13
Properties (Icon bar) 28

Q Quality (Printer) 86
Quick selection (Line type) 4

R Radius (Circle) 55
Reference line (Dimensioning) 113
Remove (Fillet) 17
Remove (Layers) 22
Resolution (Spline) 41

S Save (DXF) 31
Save (Files) 9
Scale (Edit functions) 99
Scale (Settings) 13
Scroll wheel (Mouse) 3
Selection (Origin) 51
Selection (Geometric elements) 26
Selection (Element) 26
Selection menu (Icon bar) 28
Separate (Circle) 17
Separate (Lines) 17
Settings (Printer) 84
Setup (Printer) 85
Shifting (Entry format) 5
Shortcuts (Command line) 6
Shortcuts (Command sequence) 6
Show/hide (Grid) 4
Simple (Text) 79
Spline (Lines) 109
Symbol (Rectangle) 29
Symbol (Drawing) 29
Symbol (Cursor) 7
Symbol (Tangents) 30
Symbol (Lines) 30
Symbol (Circle) 30
Symbol (Construction lines) 29
Symbol (Fillet) 30
Symbol (Selection) 29
Symbols (Macros) 31
Symbols (Text) 122

T Tangential (Arc) 63
Tangential (Construction lines) 76
Tangential (2 elements) (Arc) 65
Text (Formats) 81
Text mode (Command sequence) 4
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Through a point (Circle) 58
Tip (Construction lines) 29
Tip (Geometric points) 4
Tip (Grid) 4
Torch cutting (Macros) 123
Triangulation (Cursor) 5
Triangulation (Coordinates) 5
Triangulation (Entry format) 5
Trim (Geometric elements) 29
Trim (Lines) 17
Trim (Circle) 17
True-type (Text) 81
True-type settings (Text) 83
True-type text (Formats) 83
Types (Lines) 11

V Values (Geometric points) 26

X X/Y (Coordinates) 5
X/Y coordinates (Cursor) 5
X/Y coordinates (Entry format) 5

Z ZEW (Files) 31
Zoom (Drawing) 3
Zoom window (Drawing) 11
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